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Введение

Прежде чем окунуться в мир Photoshop, следует составить себе общее представление о месте и роли этой программы в большой семье графических редакторов, разобраться с принципами формирования изображения и восприятии его человеком.
Цель нашей работы -  это изучение различных групп фильтров и применение их на практике. Для достижения поставленной цели необходимо решить следующие задачи: рассмотреть возможности, назначение, недостатки и недоработки Adobe Photoshop CS2; дать общее понятие фильтра в Adobe Photoshop CS2 и изучить действие различных групп фильтров в Adobe Photoshop CS2 на графические изображения. Выбор темы работы обусловлен личным интересом автора к данному исследованию.
Photoshop CS2 (версия 9), являясь, по сути, растровым редактором, содержит в себе элементы (инструменты) векторной графики, позволяет создавать Web-изображения и 2D-анимацию. В цифровом мире имеется два основных способа представления изображений. В обоих случаях реальное непрерывное изображение разбивается на элементарные объекты, но описываемые различными методами. Один способ - векторная графика – представляет собой математическое описание составляющих элементов (объектов) изображения– кривых и прямых линий, а также элементарных геометрических фигур (прямоугольников, эллипсов и т.п.). Другой способ, растровая графика, заключается в том, что реальное непрерывное изображение разбивается на точки, называемые пикселями, причем каждая точка обладает точно определенными координатами (номер строки и столбца, как ячейки таблицы). Кроме этих двух видов графики, в отдельные виды выделяют фрактальную графику, трехмерные (3D) изображения, анимацию (2D и 3D) и изображения для Web, хотя все они, по сути, являются какой-либо разновидностью либо векторных изображений, либо растровых, либо используют механизмы и той, и другой одновременно. [4, c.19-20]
Глава 1. Описание программы Adobe Photoshop CS2
§1. Возможности Adobe Photoshop CS2
Программа Adobe Photoshop предназначена для любых работ, связанных с                               созданием и обработкой пиксельной графики.
К изображениям с которыми работает программа, можно отнести книжные и журнальные иллюстрации, разнообразные фотоснимки, слайды, видеокадры, кадры мультипликационной график и т.п.
Широкий спектр изображений обеспечивает уверенность в том, что эта программа - удачный выбор для множества специалистов, творческих работающих с изображениями. 

И поэтому мне бы хотелось перечислить основные функциональные возможности и достоинства Photoshop CS2:
· обработка растровых документов с использованием многих средств, способов и приемов, обеспечивающих оптимальный их выбор в каждом конкретном слу​чае;

· высокое качество обработки растровых изображений;

· широкие возможности оформления объектов документа различных типов с использованием эффектов слоев, а также стилей оформления слоев;

· широкие функции по работе с текстом растрового документа, позволяющие, в частности, формировать текстовые дорожки, создавать в текстовых блоках эффекты искривления, а также выполнять стандартные операции обычного текстового редактора;

· формирование в изображениях многих художественных и корректирующих эффектов с помощью команд фильтрации;

· широкий выбор средств автоматизации обработки растровых документов;

· использование современного механизма цветового управления, базирующегося на стандартных цветовых профилях;

· создание электронных версий растровых документов для их публикации в Web;

· оптимизация файловых параметров вырезок, доступных для сохранения в файлах любых растровых форматов, используемых в Web;

· возможность переноса обрабатываемого документа в программу ImageReady CS2 для его доработки там с целью расширения его возможностей при электронной публикации;

· высокая эффективность создания художественных эффектов с помощью 47 из 107 команд фильтрации, для которых предусмотрен быстрый поиск требуемой команды, а также произвольное комбинирование нескольких команд в режиме просмотра результата их действия на обрабатываемое изображение;

· возможность использования предварительно заданных наборов параметров (предустановок) инструментов Adobe Photoshop CS2, обеспечивающих эффективность работы с этими инструментами;

· корпоративная обработка растровых документов через сеть многими пользо​вателями под управлением программы Version Cue 2.0, входящей в графический пакет Adobe Creative Suite CS2;

· настройка быстрых клавиш и меню команд (основного и контекстных меню палитр);

· удобство эксплуатации рассматриваемой программы. [2]
§2. Назначение, недостатки и недоработки Adobe Photoshop CS2

Назначение 
Программа растровой графики Adobe Photoshop CS2 создана известной фирмой-производителем графических программных продук​тов Adobe Systems Incorporated. Она предназначена для разработки растровых до​кументов с целью их публикации в виде типографской продукции, а также для элек​тронной публикации в качестве графических Web-страниц или их составных частей. Программа является в настоящее время самым совершенным и популярным средством обработки документов растровой графики. Она допускает обработку доку​ментов совместно с программой Adobe ImageReady CS2, устанавливаемой вместе с ней. Обе эти программы входят в состав пакета графических программ Adobe Creative Suite CS2.

Недостатки

Все существующие недостатки программы Photoshop CS2 (а без них не обходится ни одна реальная программа) можно разбить на три группы:

· недоработки, вызванные ошибками разработчиков или нарушением заданных условий эксплуатации программы;

· сравнительные недостатки, связанные с невыполнением отдельных функций, которые реализованы в других программах растровой графики;

· недостатки совместной эксплуатации программ Photoshop CS2 и ImageReady CS2.

Недоработки

Перечислим несколько недоработок программы:

· • при электронной публикации PDF-файла, сформированного из растрового документа, содержащего различную управляющую информацию (в том числе и ги​перссылки), предназначенную для такой публикации, вся эта информация теряется;

· • в палитре Brushes (Кисти) предусмотрен режим просмотра рабочего профиля кисти лишь в оттенках серого цвета, что не позволяет контролировать параметры профиля, задаваемые на вкладке Color Dynamics (Цветовая динамика).[1,c.5-7]

Глава 2. Фильтры Adobe Photoshop CS2
§1. Общее понятие фильтра в Adobe Photoshop CS2
Общие понятия о фильтрах

Фильтры входят в число наиболее сложных элементов Photoshop. Научиться ими пользоваться несложно, но правильно их применить - это целая наука, которую можно постигать очень долгое время. Если вы собираетесь совершенствоваться в работе в Photoshop, то именно на фильтры вам стоит обратить самое пристальное внимание. Для использования всех остальных инструментов требуются только технические действия, и постижение работы с ними обычно ограничивается ознакомлением с интерфейсом и выполнением двух-трех упражнений. Работа с фильтрами - гораздо более творческий процесс,

и самое важное - научиться комбинировать различные фильтры для достижения разнообразных результатов. В этой главе рассматриваются основы работы с фильтрами - те сведения, которые будут вам необходимы для полноценного использования фильтров. Также вы найдете здесь несколько советов, которые помогут вам правильно сориентироваться в назначении тех или иных фильтров.

Что такое фильтр?
Фильтр - это некий алгоритм, по которому преобразовывается изображение. Поскольку существует бесконечное множество способов, с помощью которых можно изображение преобразовать, то и возможных вариантов фильтров также очень много. В Adobe Photoshop CS2 их около 100. Их точное число знать необязательно, главное - уметь фильтры применять. Фильтры служат для различных целей. Некоторые из них созданы, чтобы имитировать определенные художественные техники, другие - для исправления недостатков изображения и придания ему большей четкости, третьи - для достижения каких-либо особых эффектов.

Как применить фильтр?
Применить фильтр к изображению или его части совсем несложно. Все необходимые для этого команды сосредоточены в меню Filter.

В первом разделе этого меню расположен единственный пункт с названием последнего примененного фильтра. Если щелкнуть по этому пункту, то фильтр будет применен еще раз. Далее следуют три особых фильтра- Liquify (Исказить), Extract (Извлечение) и Pattern Maker (Создатель узора), которые несколько отличаются от остальных более сложным интерфейсом и расширенными возможностями. Они рассмотрены подробно ниже в этой главе.
Как уже упоминалось ранее, галерея фильтров применяется, чтобы собрать в одном месте некоторое количество несложных фильтров Photoshop использовать их одновременно.

При работе с этим модулем используется схожий с послойным подход к использованию фильтров. Фильтры можно применять в любом количестве и в любой последовательности, гибко менять их порядок и удалять ненужные. Все

изменения будут немедленно отображены в области предварительного просмотра.

Окно Filter Gallery состоит из трех частей, разделенных вертикальными линиями. Первая из них — это уже знакомая нам область предварительного просмотра. Во второй перечислены все доступные группы фильтров, и, щелкая по пиктограмме рядом с названием группы, можно получить доступ к отдельным фильтрам.

Щелкая по миниатюре фильтра, вы применяете его к изображению, и в правой части окна появляются параметры, определенные для этого фильтра.

Как ограничить действие фильтра

Довольно часто возникает ситуация, когда фильтр нужно применить не ко всему изображению, а лишь к некоторой его части.

Самый удобный способ решения этой проблемы - использование выделения. Как и любой другой инструмент преобразования в Adobe Photoshop CS2, фильтр применяется к выделенной области, если таковая существует. В этом случае неоценимую помощь вам окажет растушевка выделенной области. Создав, таким образом, плавный переход между областями, вы добьетесь более естественного эффекта.

Другой способ, который обладает большей гибкостью, это использование двух слоев, к одному из которых применяется маска. Алгоритм применения этого способа таков:

1. Исходное изображение помещается на новый слой.

2. Создается копия предыдущего слоя.

3. К новому слою применяется один или более фильтров.

4. Для этого слоя создается растровая маска, которую впоследствии можно редактировать.

Достоинства этого способа станут, очевидны, как только вы приступите к редактированию маски. При помощи кисти вы вручную обрисовываете нужную область, к которой нужно применить фильтр, а используя линейный градиент, легко создать плавный переход любой - и главное, моментально редактируемой - ширины. Если вы переключитесь на работу с радиальным градиентом, то создадите быстро регулируемую область применения фильтра, по виду которой иногда трудно определить, имеет ли она правильную форму. Причина этого- в использовании фильтров, которые зачастую меняют привычные геометрически пропорции.

Того же самого эффекта можно добиться, если использовать быструю маску (quick mask) для создания выделенной области. Однако если применять ее к однослойному изображению до наложения фильтра, то будет потеряна всякая гибкость редактирования. Можно использовать этот метод для редактирования маски верхнего слоя, по сути, это ничем не будет отличаться от метода, описанного чуть выше.
Ослабление действия фильтра
Этот прием несколько не обычен для Photoshop, поскольку позволяет ослабить действия фильтра после его применения к изображению. Суть его состоит в том, что он позволяет осуществить смешивание двух слоев: исходного изображения и измененного после фильтрации.
Чтобы получить доступ к этому фильтру нужно выбрать команды: Edit – Fade.

Меняя значение параметра Opacity, вы регулируете степень влияния этих слоев на конечный вид изображения. Нулевому его значению соответствует отсутствие влияния фильтра, а 100% полной, неослабленной фильтрации. Промежуточные значения визуально ослабляют действия фильтра. Ослабление будет различаться в зависимости от режима смешивания.[5,c.198-200]
§2. Различные группы фильтров в Adobe Photoshop CS2
Фильтры групп Artistic и Sketch

Фильтры этой группы предназначены для имитации различных техник рисования, используемых художниками, - сухая кисть, цветной карандаш, губка и некоторые другие. В то время как фильтры Artistic (Художественный) служат для имитации полноцветного художественного рисунка, фильтры группы Sketch (Набросок) имитируют набросок (его еще называют эскизом). Он отличается от рисунка тем, что состоит всего из двух цветов, - они совпадают с цветами переднего плана и фона в Photoshop. Придав нужный оттенок этим цветам, можно добиться того, что области открытки, которые подверглись воздействию этого фильтра, не будут выделяться относительно остальных.
Фильтры групп Blur и Sharpen

Эти фильтры нужны для размывания изображения. Применяются они часто и много - размывание является очень нужной операцией, например, для того, чтобы убрать шум.
Два простейших фильтра - Blur (Размытие) и Blur More (Добавочное размытие) - просто немного размывают выделенную область. Фильтр Average (Средний) обладает еще более простым действием - он заливает все изображением его усредненным цветом.

Чаще всего из фильтров этой группы используется фильтр Gaussian Blur (Размытие по Гауссу). Он обладает рядом полезных параметров, и с его помощью можно создать некоторые эффекты, основанные на размытии.
Например, если вы создадите быструю маску в виде градиента, переведете ее в область выделения и примените к ней этот фильтр, то получится так называемый эффект глубины резкости (depth of the field). Он имеет место при любой реальной фотосъемке - предмет, находящийся в фокусе камеры, выглядит резко, а остальные - расплывчато. Противоположным действием обладают фильтры группы Sharpen (Резкость).
Фильтры группы Brush Strokes

Brush strokes переводится как штрихи кисти. Именно этот эффект и имитируют фильтры данной группы. Имитация рисования чернилами, перекрестная штриховка или подчеркивание краев выполняются именно этими фильтрами. Если различные фильтры этой группы применить к каждой отдельной елке, то они все будут выглядеть по-разному, что подчеркнет их индивидуальность.

Фильтры группы Distort

Фильтры группы Distort (Искажение) вносят визуальные искажения в общую картину: волны и рябь, вдавливание и выпячивание. Эффекты могут быть как небольшими, косметическими (при малых значениях параметров искажения), так и гротескными.
Фильтры групп Noise и Pixelate

Фильтры групп Noise (Зашумление) и Pixelate (Пикселизация) объединены в один раздел не случайно. Действие их весьма схоже. Фильтры первой группы нужны для добавления (или удаления) зашумления в изображение. Параметров у них немного или же они отсутствуют вообще. Зашумленное изображение, как правило, неприятно для глаза и поэтому притягивает внимание. Этим эффектом можно воспользоваться и в нашем проекте.

Фильтры, группы Pixelate применяются для эффектов пикселизации - один из пикселей увеличивается в размере и перекрывает собой остальные.
Фильтры группы Render

Фильтры группы Render (Визуализация) отличаются от остальных тем, что добавляют в изображение элементы, внешний вид которых слабо зависит (или не зависит вообще) от вида базового изображения. Это облака, волокна или эффекты линзы.
Отличительным в этой группе является фильтр Lighting Effects (Эффекты освещения). В его диалоговом окне можно определить несколько источников освещения и область их действия. 
Фильтры группы Stylize, Emboss, Texture, Video
В стандартную поставку Photoshop входит еще три группы фильтров. В первой из них - Stylize - находятся фильтры, которые значительно преобразуют изображение или выделенную область. Они позволяют, например, выделить края или покрыть изображение мозаикой. Чаще всего из них применяется фильтр Emboss, который позволяет имитировать рельеф, используя яркость пикселей.
Фильтры группы Texture (Текстура) накладывают на изображение текстуру и смешивают ее в режиме, похожем на Overlay (Наложение). Фильтры в подменю Video (Видео) имитируют переход в цветовое пространство NTSC и устраняют через срочность изображения. [5, c.208-214]
Работа с фильтром Liquify
Фильтр (часто его называют командой) Liquify является, пожалуй, самым сложным и богатым возможностями. Он используется для ручного искажения изображения. Применяя различные инструменты, вы самостоятельно смазываете, скручиваете или каким-либо образом искажаете изображение и затем закрепляете произведенное изменение.

Чтобы запустить фильтр Liquify, выберите одноименную команду из меню Filter или нажмите комбинацию клавиш Ctrl+Shift+X. Обратите внимание на то, что комбинации Ctrl+Alt+X и Ctrl+Shift+Alt+X запускают два фильтра (Extract и Pattern Maker), по интерфейсу схожих с Liquify. Эти клавиатурные сочетания несложно запомнить. Окно галереи фильтров состоит из трех смысловых частей:

· панель инструментов - она похожа на панель инструментов Photoshop, но отличается меньшим количеством инструментов и отсутствием выпадающих меню для них;

· область предварительного просмотра - самая большая часть окна Liquify, она служит для оценки результатов работы. К ней можно применить те же команды навигации (с использованием клавиш пробела, Ctrl, Alt и мыши), что и к обычному окну изображения в Photoshop;
· панель опций и параметров - используется для задания численных данных и опций инструментов, просмотра изображения и работы с масками.

Работа с фильтром Extract

Фильтр Extract предназначен для выполнения сложных операций маскирования. Суть таких операций пояснить несложно. Имеется некоторая фигура (человек или предмет), которая расположена на сложном (то есть неоднородно окрашенном) фоне. Требуется отделить эту фигуру от остального изображения. Сложность состоит в том, что с помощью одной команды (например, Magic Wand) невозможно выделить весь фон, а работа с масками окажется довольно долгим занятием.

Количество инструментов фильтра Extract невелико – их всего три. С помощью первого из них под названием Edge Highlighter (Подсветка краев) следует очертить края нужного объекта. При рисовании возникнет полоса, окрашенная по умолчанию в ярко-зеленый цвет. Внутри нее позднее будет создана переходная (между фоном и предметом) область. Поэтому если фигура имеет сложный или витиеватый контур, то он полностью должен быть закрашен зеленым.

Если вы активизируете режим Smart Highlighting (Интеллектуальная подсветка), то при ведении указателя мыши вдоль края изображения размер и положение кисти будут автоматически варьироваться таким образом, что создаваемая область станет наиболее точной и толщина ее будет минимальна.

Используя инструмент Eraser (Ластик), мы стираем часть краевой зоны, нарисованной Edge Highlighter. Инструмент Fill (Заливка) служит для определения областей, которые следует оставить в результате операции исключения. Чтобы такую область можно было залить, она должна быть замкнутой. Если вы нарисовали не один контур, то и областей таких может быть несколько. Для предварительного просмотра результата нажмите на кнопку Preview (расположенную рядом с кнопками ОК и Cancel). Чтобы вернуться в режим обводки контуров, выберите пункт Original (Начальный) в списке Show (Показать) в разделе Preview.
Работа с фильтром Pattern Maker.
Фильтр Pattern Maker является самым оригинальным и непредсказуемым из сложных фильтров в Photoshop. Он используется для того, чтобы на основе некоторой части изображения создать узор, при повторении которого не будет ярко выраженных швов. Причем, используя одну и ту же область изображения, можно создать бесчисленное множество узоров.

Воспользоваться им еще проще, чем фильтрами Liquify и Extract. Нужно всего лишь запустить фильтр из меню, выделить в его окне нужный фрагмент изображения и щелкнуть по кнопке Generate (Создание). Щелкая по ней раз за разом, вы будете получать все новые узоры. Чтобы вернуться к предыдущим узорам, воспользуйтесь кнопками перехода в разделе Tile History (История мозаики).

В разделе Tile Generation (Создание мозаики) можно задать следующие параметры узора: длину (width), высоту (height), тип и величину смещения (offset), сглаженность (smoothness) и количество деталей (sample detail).
Заключение
В научной работе были рассмотрены различные группы фильтров программы Adobe Photoshop CS2).
Фильтры, встроенные в  программу Adobe Photoshop, позволяют применять к изображению различные специальные эффекты. С их помощью можно создавать мозаичные эффекты, случайным образом перераспределять цветовые значения пикселей (добавлять или уменьшать шум), имитировать присутствие различных источников света, произвольно деформировать изображения,  а  также получать многие другие интересные визуальные эффекты. Кроме того. «Заказной фильтр» позволяет нам создавать и сохранять собственные уникальные эффекты, а затем применять их в других изображениях. 
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Приложение 1.
Пример использование фильтров для создания «загадочного узора»
Создаём новый документ с размерами холста 1600*1600px, т.к. конечный результат может занять только 50% нашего холста. Примеры буду приводить размером 25% от оригинала (т.е. 400*400px). Зальем фон чёрным.
II. Далее применяем Filter >> Render >> Fibers с настройками: Variance: 20; Strenght:20.


Выбираем Rectangular to Polar.

[image: image1.jpg]



Затем применяем Filter >> Blur >> Radial Blur. Настройки: 100; Zoom; Best. После выполнения фильтра повторяем его действие (Ctrl+F)
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Далее применяем Filter >> Render >> Lighting Effects с настройками:
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Результат:
[image: image4.jpg]



Добавляем контраста: Выбираем Levels (Ctrl+L) и выставляем следующее:
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Результатом должно быть что-то вроде следующего (главное чтобы лучи не достигали краёв холста!):
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Получили заготовку. Теперь я хотел бы как-нибудь её раскрасить. Я придам ей огненный цвет. Итак, в окне Layers к слою с заготовкой создайте карту градиента, но немного видоизмените сам градиент так, чтобы фон остался чёрным. Для огненного цвета:
I. Создадим карту градиента:
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Используйте этот градиент:
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Нажав на сам градиент в окне замените синий цвет на чёрный:
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Нажмем Ok и сольем маску со слоем. Результат:
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Применяем Filter-Distort- Polar Coordinates
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*Переворачиваем на 180 градусов и жмём Ctrl+F (повторяем действие Polar Coordinates)
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Повторяем пункт *
[image: image13.jpg]



Перевернем изображение и примените фильтр Polar Coordinates два раза. Затем опять переверните и на этот раз примените фильтр один раз. 
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Скопируйте слой с узором Blending Mode поставьте Lighten. Нажмите Ctrl+T и поставим угол поворота 90градусов.
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Теперь быстро нажмите: Ctrl+J , Shift+Ctrl+T , Ctrl+J , Shift+Ctrl+T
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Слейте все слои, скопируйте новый, Blending Mode измените на Lighten, нажмите Ctrl+T и поставьте угол поворота 45градусов.
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Приложение 2.
Обработка фотографии

1. Выберите в основном меню healing brush. Определите область воздействия нажав клавишу Alt. 
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2. Проведите несколько линий (зажимая Alt) по здоровым участкам кожи с волосяным покровом и порами (именно эти участки будут выбраны программой как эталон). Затем проводите кистью по участкам кожи, которые вы хотите отретушировать. Запомните, не нужно закрашивать всю кожу целиком: вы хотите сохранить текстуру кожи. Используйте разные слои и уровни непрозрачности. 
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3. Так ваша кожа должна выглядеть после использования healing brush. Обратите внимание - некоторые области уже готовы. 
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4. Верните немного реальной текстуры под глазом, так что бы это выглядело предельно натурально. То же самое можно проделать там, где вам кажется необходимым. 
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5. Дублируйте слой с отретушированным изображением несколько раз. Многократно используйте фильтр despeckle (Filter > Noise > Despeckle) на одном из слоёв и разные варианты smart blur (Filter > Blur > Smart Blur) на остальных. Настройте уровень непрозрачности на каждом новом слое и сотрите высокодетальные области, (такие как глаза, брови и другие) что бы они были чётко видны (Расположите слои так, что бы основной слой был ниже остальных). Комбинируйте слои, настраивайте непрозрачность, а затем объединяйте с основным ретушируемым слоем. 
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6. Для очень гладкой кожи используйте фильтр gaussian blur с большим радиусом. Здесь я использовал радиус 77.5 pixels. Как только вы размыли изображение, воспользуйтесь soft eraser brush 20% для того, что бы стереть некоторые размытые области рисунка. Я использую её на глазу, брови, крае носа, щеке, губах, наушнике и волосах. 
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7. Как только вы закончите работу с ластиком установите режим отображения слоя screen mode, изображение станет очень светлым, но это хорошо. Установите уровень непрозрачности по вашему вкусу с слейте слои вместе (в меню Layer > Merge layers или выберите другой необходимый вариант) Затем откройте levels (Image > Adjustments > Levels…) и перемещая среднюю стрелку затемните ваше изображение снова. 
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8. Отрегулируйте цветовой баланс (Image > Adjustments > Color Balance) и готово! 
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